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Thanks for choosing us!
If you have any question or concern, supportis
available by email . Problems could be resolved

quickly.

E-mail: support@printer-support.cn
Website: www.printer-support.cn

Scan QR code to download the User Manual:
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1.Appearance

Release Latch

77X

Print Head

7777277

.

Paper Cutter —»

=777,

Roller

Paper Guide

Power Supply Port

USB Cable Port
Power Switch(O=off I=0n)

2. Packing list

Printer 1 Fan-fold Label User Manual

S

Power Adapter & Cable USB Cable U disk Label paper sample

A Note:

If any accessories missing, please contact us to get support.



3.Printer Connection
A Note:

m Make sure the printer's power switch is in the OFF position
before connecting the power cord to printer.

®m Use the original power adapter only in case the damage
caused by charging improperly.

B Please unplug the printer power cord if it is not in use for a
long time.

[EIER

 E—

Ensure the printer is off

EEE

Connect the power

[Ie
—

Plug the power cord into the socket Connect the USB cable to the printer

SR

| I—

Connect the printer and computer Turn the power on



4.The suitable label size

® Shipping label printer works with any Thermal Direct
with a width range from 1.57" to 4.1", length over 0.8".

Normal paper is not applicable! Must beTHERMAL LABEL!
m |deal for 47*6”

B Paper size can be selected in Windows and MacBook both.

Label standard size

. 4“!6" . 41lx3" . . 4"x2" i 3“!2"

5.How to feed label

==k
[C @ }
Ensure the printer is off Pull the release latch to open the cover

Insert the fan-fold label or roll label
from outside, adjust the paper guide
to fit the width of paper

A Note:

Ensure the print layer of label face
up in case print out blank labels.




Close the cover, switch on the printer and
wait 5 seconds for the printer to initialize.
— Long press the feed button until you hear
one beep, release your finger, the label
Feed button calibrates automatically and will be

— | ) p03|t.|oned at the tear-off point, then ready
to print.

A Note:

B Each time you change the label, please follow the above steps
5.1~5.4.0Otherwise, it may cause printing out misaligned or blank.

B Everytime you open the label cover even you never change

the paper, you'd better to press the feed button once to load one
sheet paper.

6.Installation for Windows

A Note:

Recommend to close security software before installation in case of
preventing installation

B Thermal label printer is compatible with windows
7 or later, not compatible with Chrome book, Linux,
windows ARM.

B |nstallation guide video in our website.

Step1: Install the driver

a. Connect power and computer (Please skip this step
if you have finished it before.)

1) Connect the power to the printer through power cord.
2) Connect the printer to your computer through USB cord.

A Note:

Each time you connect USB port, make sure this connection with a same
port, otherwise a printer copy will appear.
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3) Put the labels in, switch on the printer, Long press the feed button until it
beep once, labels will keep forward and back for several times and then
be postioned at the tear-off point, it means the printer is ready to print.

(Make sure these three steps are completed before installation in case of
failure to install the printer driver)

b. Install the driver and printer for Windows

Please download the driver from website and install it , then follow the guide
to install printer .

1) Setup - LabelPrsterDivner

Select Destmation Lecation

ivtanre b Lkl e Dr e b irvtalee !

m= Printer Driver Setup v1.0.0 - X

T gy vl ircilall LabselPriviber Doy inbs Bae Following fokder.

To corvanue, dick Mext. 1F you would e o select & diffenent folder, didk Browse. Printer Type: LabelPrinter ~
[ FTENHNEHF: LabelPrinter

Default Printer

(®)UUSB port - Connect the printer to your computer using a USB cable
() Serial port - Connect the printer to your computer using a serial cable

() Other port - Connect the printer to your computer using other ports

Atleast 2860 of free dek space & requined.

[ texi> ] | Concel

Click “Get USB Port” to get the USB port which your computer connect to the
Label Printer(4inch). and then click “Setup”. The printer will be successfully set
up.

m= Printer Driver Setup v1.0.0 - X

USB Port:

USB003 ™ Get USB Port

< LastStep Next Step >

wmm Printer Driver Setup v1.0.0 - X

LabelPrinterInstalled printer .
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ﬁ! Setup - LabelPrinterDriver —

Completing the LabelPrinterDriver
Setup Wizard

Setup has finished installing LabelPrinterDriver on your
computer.

Click Finish to exit Setup.

If you get the tips “Finish” , that means your computer
and printer didn’t connected via USB port , please
connect them , then install the driver.

c. After setting up the printer, check your computer if the printer has
installed or not.

Go to the “control panel”> click “Device">click “Printer & scanners”, and then
you will find the printer “Label Printer”, if you can find “label printer " and print
labels successfully, that means you have set up the printer successfully.

If you can't find the printer you have installed, please restart your computer
and printer then try again.



fa

Settings

Home

Devices

m
&

Blsetoath & other devices

Prenlers & scanners

Kouse

Typersy

Pan & Windows Ink

AutoPlay

A Note:

Now you can print directly via USB, if you want to print via
Bluetooth, please follow the steps below. But if your printer type
is Label Printer (non-Bluetooth) please skip Step 2 and Step 3.

Printers & scanners

Add printers & scanners

Add 8 privler of scamner

Printers & scanners

Faw

LabetPrinter

Microzoft Pnnt to PDE

Microsolt XPS Document Wiiber

® © b

7. Installation for Mac

A Note:

m Shipping label printer is only compatible with
MACOS X v 10.9 or later.

B |nstallation guide video in our website.

B Ensure the printer and your MAC has been
connected with USB cable before installing

the driver.



Step1: Install the driver for Mac

a. Connect power and computer
1) Connect the power to the printer through power cord.
2) Connect the printer to your computer through USB cord.
3) Put the labels in, switch on the printer. Long press the feed button until it
beep once, labels will keep forward and back for several times and then
hold on one place, it means the printer is ready to print.

(Make sure these three steps are completed before printing in case failing to
install the printer driver.)

b. You can also download the driver “Driver for Mac (Label Printer)” from
our website.

s “Label Printer-Mac0S.pkg” can’t be opened
m because it is from an unidentified developer.

Your securily preferances allow installation of enly
apps trom the App Store and identified developers.

? oK ]

c. Open "System Preferences”, and click on “Security & Privacy”.(If you
don’t see the warning , you can skip this step)

Lomernr @l Deakiog & D LT L s guagm SEcurty Seothght Hgtificabans
SCHee Saver Contral B Gwgpon & Privmcy

& 0 &

J =
Enargy L= [L-T ) Trackpsd  Preprs A

Seartup
Savme Boarery D
Chonid [l LY Serftmirs St Hherloofti  Enteraion S g
ArTy Unpidat L
Th e
& ® © = @
& - \.d 2 *

ey & Farent - n Cate & Tea Tirnm ALCENBItETy
¥ 1 Conirels (Y ]



d. Click on "Open AnyWay”button. (If you don’t see the warning, you

can skip this step)

L{.p:_t | = -.:‘u“____ I.;, - l

BEEE revn  rrewn  ormey

& g, peaTEe s hean S fr D08 usE  Change Panden
B hguin pesamery cretateny [ @nee smep e scrven st tegre

Tma 4 L. e P g A

adture wppe comrasaded Nom

50 Bl e | P
¥l 1y

inl : Bt Opds Aeymay
[EIER e ———

* Label Printer-MacOS.pkg * is from an
unidentified developer. Are you sure you
want to open it?

Opening “Labal Printer-MacOS.pkg* will always allow it
o run on this Mac.

“Label Printar-MacOS.phg = 5 on the dink image
"BerprtPricitar vl 3 dmg” Satan downloaded this disk
anage oday @ 15 &4 o

open,  (EEEINN

e. Click on “open” and continue to install the printer. Follow the installation
steps until you see " The installation was successful" window.

Change fnstall Location_.

Customize Go Batk incstad

KX . esallselpetevena @0 @ instal Lobe! Printer Vert3
Welcome 1o the Label Printer Ver1 3 Installer Select a Destination
: MLibearyiPrintsrs/L abeiPrintee/

ey Tom v e b e o e it v Select the disk where you want 1o install the Label Printer

Varl.3 software.
Destirisfioh Belect s & Destination Select
0 ratullatian Typ ’
Macos
441,05 GO svailable
45976 G& wtal
Installing this software requires 69 K8 of space.
You have chosen to install this software on the disk "macos”,
Continus Go Back C\*\Iinur
o i nstail Lube Prioter Vet 3 _ [ » atal Label prinser Verld
Standard Install on *macos® The installation was completed successfully,
— This will take 69 KB of space on your computer, o' Intechiclion
» Destination Salect Click Install to perform a standard instaBation of this software « Destination Select
« installation Type n the diak ' macor, « Installation Type
taflutior » Installation
-l The installation was successful.

The softwane was installed.



f. Open "System Preferences">>click on "Printer and Scanners".

g. Click "+" to add a new printer.
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h. Click on Thermal Label Printer, and choose "Select Software" in the
drop down menu.

o0 ® Add

l‘:'* I -_‘::; ‘--lr

N Q, Search

Name: |Therrna| Label Printer

Location: | ETMIMacBook Pro

Use: [ Choose a Driver...

Suftware for this pricter st ASaliabie from Apple: Contact the prite
manufacturer for the latest software.

Add

i. Choose “ Label printer” | click “OK”.

Epson 24-Pin Series
Epson 9-Pin Series
EPSON FAX

EPSON FAX A3

HP DeskJet Series
HP LaserJet Series PCL 4/5
Inteilitech IntelliBar Label Printer, 2.3
Label Printer

LabelPrinter Label Printer

Oki 24-Pin Series

Cancel |

11



j. Click “Add”, now the printer has been installed in your Mac book
successfully.

‘sce® Add
| O ' ' ._ - Q Search _;

MName: |Th¢rma| l.abel Pr'ihter

Location: | £ #MacBook Pro

Use: | Beefyt BY-426 Label

| Options & Supplies... |

Localion. ET#MacBook Pro
Mind: Beeprt BY-426 Label
Status: hdia

| Share this printer on the network | Sharing Preferences...
)

Default printer: = Last Printer Used

B
Default paper size; | US Letter B -

A Note:

Now you can print directly, if you want to adjust the printing density,
printing speed or other parameter, please refer to “part 8 Printer
preference setting”.

12



8. Printer preference setting
1-1.Printer preference setting for windows

Go to the “control panel”>> click “Device”>>click “Printer & scanners™>>find
the printer “Label Printer’>>Click “manage”>> click “Printer Preference”. In
this part, you can set the print page size and print speed and density of the
label.

(1)Setting the paper quality

a. Go to “Page Setup”, according to the label size, choose the corresponding page size.
Generally, most labels are 46 size.

A Note:

before printing, please make sure the size loaded thermal labels,
the print settings on devices, and the source file are completely the same.

E&Q LabelPrinter Printing Preferences it

Page settings

—Paper

Paper Name: |4" *5"(101.6mm*152.4mm) j

17 * 2%(25.4mm*50,8mm)

100mm* 150mm

100mm*180mm

100mm*200mm

rSetting————————2" * 4"(50.8mm*101.6mm) 1
; 2,257 * 1,25%(57. 15mm*31. 75mm)

Print speed: |4 12,257 = 4°(57.15mm*10 1. 6mm)

3" * 2%(76. 2mm*50.8mm)

Print darkness: Is 4" * 4 'i ml.ﬁmm*lul.ﬁmmi
—Position Adjustment 50mm*30mm
W - T 150 0L
orizan I _I; mm 1234567 |
) = 270
Vertical IU _Ij mm

—Media Settings

Paper type: Ilabel 'rl Gap offset: Iu _|:‘ mrm
Paper feed after II.’J _|; mm Gap height: |3 _l:: mm

Cancel Apply
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b. In the “Page Quality”, you can change the printing speed and printing darkness.

(Especially for density, if the labels print
out light or not clear, you can change

the density to lager number, it will help.

The larger number you choose, the
darker the label will be. 8-12 is
recommended)

(2)Print a sample file.

a. Open the a PDF file in the size of 4*6 inch size with Adobe, click the print sign, ensure you
have choose the right printer. (If you want to print word file, please transfer it to PDF file

then print to get the best out print)

@ LabelPrinter Printing Preferences

Page settings

—Paper
= =g =l S 4" * 5°(10 1, 6mm™* 152, 4mm)
New Edit Delete
rE=ig rRotate — ~Preview
Print speed: |4 %0
Print darkness: Ia vl ol
ABCD
rPosition Adjustment
—— cw | |||l
orizon I_:|, mm 12587 |
. . 0
Vertical Hmm
~Media Settings
Paper type: Ilabel vl Gap offset: IO _I:' mm
Paper feed after I 0 _Ig mm Gap height: I 3 _Ij mm

Cancel Apply

Print b4
= ~
Priter (RIS Properties Aglvanced Help L
Copies: |'| - |_] Print in grayscale (black and white)
[ ] Seve ink/tones @
Pages to Print Comments & Forms
() Al Document and Markups bl
Cutrenl pagd
[ Surmmarize Commenis
Pages 1
¥ hoee Opfions Scale: 100%
4 x 599 Inches
Page Sizing & Handling (1) -
Size Poster Multiple Booklet [ g To—— T LL
Cimch Ch M D 2018
O Et SR com cenyices. mic
8 F430T NANDINAAVE
() Actual size MORENO VALLEY CA 92551-8534
®) Shrink oversized pages
Ocatomscser [0 % STEE[CA9119-03
7] thoose paper source by PDF page size > %’: |I||||III|"II
AL ook CA9119-03
Ciientaticn: TRACKINGS: T241H WES (13 7153 6843
(& futo portrait/flandscape
() Partrait
() Landscape
P
< >
Pace 1.0f 1 i

14




b. You can go to “properties” , in this dashboard, you can set the page size,
printing speed and printing density too.

[;éa LabelPrinter Printing Preferences s
A NOte i Page settings
Before print, please make
. Paper
sure the size loaded thermal
Paper Name:

labels, the print settings on
devices, and the source file e = e
are completely the same.

Setting Rotate Preview
Print speed: |4 - (O]
Print darkness: |8 " ap
Position Adjustment et
Horizontal |0 _|:| mm -0 |1|!!|Jtll|s|\|?|
Vertical |0 JZI mm 2
Media Settings

Paper type: |label - Gap offset: |0 Jj mm
Paper feed after |0 JZI mm Gap height: | 3 _|:| —

e o

c. Preview and check the setting you want, such as print size, print density. Then click “print ".

If you have any problem in printing, please turn to part 10 FAQ to get the corresponding
solution, or connect us via email.

1-2. Printer preference setting for MAC

In this step, we will show you how to set the
print preference helping you print out well.

15



a. Open a sample PDF file in size of 4+6 inch , click print.

Home  Tools 4inch by Ginch labe.., x
® 8|8 Q *@@@ma?
JADENS
1525 CONSUMER CIR 48 LBS 10F2
CORONA CA 92880 DWT: 20,16,16

SHlKI\.drg.ZON COM SERVICES INC.
24300 NANDINAAV

MORENO VALLEY CA 92551-9534 :

x| CA9119-03
| I

b. Click “page setup”, you can select the page size you want to print.

A Note:
No matter what size you choose, Please make sure that the size of the
oaded thermal abels, the print settings on devices, and the source file are
completely the same.

[Print |
Printer: | Tharmal Label Printer B | Advanced Hals (D
Coples: i_i_ 1: 8 Print in grayscale (black and white)
Pages to Print Commants & Forms
o All | Ducurnlnt a‘n;i‘hia&kuu! B
- ity e ~ Summarize Comments |
Pages
*  More Options Document: 4.0 x 6.0in
4 % 6 Inches
Page Sizing & Handling (1)
Size | Postor Multiple | | Baoklet |
)
© Actual size
) Bhrink oversized pages ¥ :
Oty % (LT
Choose paper source by PDF page size
aan
g LA
© Auto portraitflandscape
") Partrait
) Landscape | = ) ==
»

] : Page 1of 1

Il _Page seyo.. Printer.. _ cancel | (N |

16



2.25"x1.25" (567.15mmx31.75mm)
2.25"x4.00" (67.15mmx101.6mm)
: : 3.00"x2.00" (76.2mmx50.8mm)

Beeprt BY-245 4.00"x4.00" (101.6mmx101.6mm)

- ' 4.00"x6.00" (101.6mmx152.4mm) -
50mmx30mm

100mmx150mm

Format For  100mmx180mm

100mmx200mm

Paper Si D

Manage Custom Sizes...
Orientation: | o

Scale: |100%

@) cancer | [

If there is no suitable size for click “manage custom sizes”, input the width
and height, then click “ok”.

c. Click “printer preference”>> Choose” printer feature”>> set up the “Darkness” and “Print
speed”.

Printer: | Thermal Label Printer B [ advenced | talo @
Coples: [1 | (2] {3 Print in grayscate (black and white}

Pagaes ta Print Commants & Forms

(-1 | Document and Markups B

() Gurrent page | Summarize Comments |

(iPagas |1

* More Options Document: 4,0  6.0in

Page Sizing & Handling (1)

[ ETTE TN

D Actual size

7 Sheink oversized pages

) Custom Scale: %

{8 Choosa paper source by PDF page size

Orientation:
10 Auto portrait/landscape
) Pertralt

| ) Landscape

(Fagesetun.. § | Primer.. crce | IS

17
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d.After set up, click “Print”

19



9.Printing via phone for Bluetooth version

1) Search and install the app "Shipping Printer".
& Q

. Shipping Printer
Jiato

(2]

13 MB Rated for 3+ @

Install

2 ) Open the app.

a.Choose file: You can load the shipping label in pdf file or image format
here.

b.Scan: You can scan the FNSKU barcode content on the website and print

them here,

L o <

20



3) Choose file:
a.Please allow access.
b.Load label image or pdf file.

WFEA BT o L= N -
L tnegefl =
Aeaw allT @V | sl aprsd O
299 AIHTO Wi 2107 IZW0AS
e O O =@
aviiano 0l oM ielleD ahagw pull
= 83413 TWESIR
L
st e v v s it
._tordenssng .._torlznasng
K3 BN TS0 B DERVER-FT ..
Allow Shipping Printer to access photos - -
and media on your device?
Allow “ o s s
i Jerlznaens
Deny M5 TEd Bl ST m

c.lcon description

Ratio: Choose different sizes or custom sizes;

Rotate Left: Rotate 90° to the left;

Rotate Right: Rotate 90° to the right;
Rest: Rotate 180°

“« Crop image

PRIORITY MAIL EXPRESS™

ShipStation
2815 Exposition Bivd
Austin TX 78703

0007
(512} 4854282

WAVER OF SIGNATUSE

SHIP

= ON BLVD
03

USPS TRACKING #

IEARARIEH

9400 1119 6900 0940 0000 11

1 O <

i »
-

Ratio

Rotate Left

Rotate Right

: Q9

d.Click the arrow in the upper right corner to enter the next step.

< Crop image




e.Click the print icon in the upper right corner to print.

Advanced

Density 6
Range 1-15

Speed 4
Range 1-8

Copies 1

fTurn on the Bluetooth function. And allow address access.

0

Allow Shipping Printer to access this
device's location?

While using the app
Shipping Printer is asking to turn on
Bluetooth. Only this time
Deny Allow Deny

22



g.Click the print icon. Print completed.

<« Print L=1
Advanced

Dengity &
Range 1-15
Speed 4
Rarige 18
Copies 1
Size

Paper width (mm) 110
Range 38-110mm

Paper height (mm) 150

Not lezs than 20mam

1] (@] <

h.Of course, you can also open the pdf file on your phone first, and then share
it to the APP to print it.

TIZE G QS

S
Qi HEas

AR Y, WETH

OneDrive PDF Viewer

ERalTE

> 0 D

Shipping Printer v




4)Scan :
a.0Open your FNSKU barcode (on website, computer or other device).

X002ZCULJ7

Thermal Direct Ship...aper Support Holder
New

b.Click the scan icon to scan the barcode. Allow access.
TNE IS *O

L~ Scan

Allow Shipping Printer to take pictures and
record video?

While using the app
Only this time

Deny

_

24



c.After scanning the barcode. You can choose different label sizes you want.

i Scan
ik el W AeRCuLy
MOTEICULIT MOTEICLUILIT
Caonfig Config
Barcode type Code 128 Barcode type SOc20mem [2'x0.787)
Density B Density 50%33mm (2°21.187)
3 50x40mm (2'x1.577)
Gpaed 4 Spaed
G0Z0mm (2.36°x0.787)
Coples 1 Coples
B0x80mm (2.36%21.577)
Size Sh0mem (270 78%) w Sire
Custom
Pt rirtund Fiserrirtand
I & < 1 O €

d.You can edit the content that needs remarks here. You can enter the number
of copies to be printed.

€  Scan oA
Density L
Speed 4
Copies 1
Size S0x33mm (2°x1.187) W

.Th.en:nnl Direct Shipping

< s and T
1213|4567 |B19]|0

giwlelritiyjullifo|p
alsldlitlginljlkle
S8 z|xic|vib|njim|§E

L2 € Englshiusy . B

1] G W =
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10. Important Tips: Print label of
multiple size using
“Take a snap shot”

The function of “Take a snap shot ” can solve most print problem. It enable
you to print the area you want without needing print a whole page. Now let
us show you how to use it.

1.How to print your labels with nonstandard size.

If the printed PDF/file is unusual size such as A4 which can't be found
the same size label to buy. In this situations, you have to use the
function of “take a snapshot” to print. Here are the steps to operate.

(1).For windows:

a. Open the PDF in Adobe Reader

b. From the top panel, select “Edit">"Take a Snapshot”, choose the area you
| |T,_.. g4 L B E Tl i oy i -

e b Mew Wiedow [elp

; Home  Toaks Hern-mTTZIE 108, .

B ABBEQA®E v RMOBE m- B

M BT ), ) SR
A e Y e o i Bl i o MR ) WY
2% 88
©
|  puncio sdn 0 5 paos Burddiys sy |

I
!
F
b
i

s, b i
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c. Then click “Print”, set up the page size that matched to the load label size. Then print.

A Note:

Please make sure the page size match to the load label size, otherwise, it is possible
that it prints out over label or misaligned.

i Labal Fﬁntﬂ Pringieyg, Praforenoes
Lisanis] Pagse Cuiskty Fage Saiup abms
Sinck
b | {17 R Aol A =]
B w0 2 [ 5 drremel, D
Nl x| S
ik | BT
10 ki = PO
2 4 (S0 Herewe | 00 Smim)|
TR 2 0 LA (. e, Fmim)
T w A [T, M 101 Bmmi]
— T % 7 [T, P femm) =
A A" (100, b 10 _:l
- _b b
Sitriom w D |
F_rl — e
 Porirail 1B =
I Larwittap 180 —
verteat: @ S
sl Suliings
Wemod | et Tharmal | Ty Luhnl viih Gaps =
GupiMar iuighe. ) < m Copiberk OffaeE 1 2|
Wacechian B echig
[ p—— [amnr Punry Page =] Fret SHinek F_ﬁ Fd
L Tanoes By
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(2)For MAC
Similarly, Mac also has analogous steps.

a. Find the “File” in the top left corner of you desktop > Click “Open” > Click Desktop >
Choose PDF file (or you can open the file with Adobe)

=
-
-
L]

PONE

b. From the top panel, select View > Rotate View > Clockwise so that the labels are side by
side. (If the labels has laid vertically, please skip this step)

@ Acrobat Reader File Edit

ec® | Rotate View > 5135306-2021-04-01(3).pdf
I Page Navigation » BN
Home Tools item-m772 f o
. R ey = £) Counterclockwise ﬂ-g
D66 EQ | TR B OO w - BT B g
Tools L4
Show/Hide >
Display Theme »
; Read Mode i .
Full Screen Mode %L i
"6 Tracker... 3
1\ Read Out Loud »
: — ;
» ] ‘ll_'.l m —— £ ——— £
i (Ve ——— - — g
5 o= o | — g
— = | ——
% [ C—— g i
— e e ﬁ
L L = | ° | — 8 )

N
oo



C. Next, from the top panel, select Edit > Take a Snapshot. Then click and drag
over one of the labels that you need. So that you can print a specific range
of label.

pbat Reader _File 0 View Window Help | " RBO® wm-R T B2 a
j e “ < B item-m77296¢
Tools iterr
©
8 = Q - SR I D a’ =
@
g =
Select All ®A g :E
Deselect All {r3A D g &
E g
= Check Spelling > &
T, i i 1
= P2
i~ Find BF S
Advanced Search {t %F E w
o
Protection = g g
Accessibility > ]\ g 2

2.1f you want to print the label that include barcode, please make sure print
out the barcode vertically in case the high temperature lead to the barcode
print out blocks and can’t be scanned.

MO 48 LBS 10F2
ém?;nm DWT- 200616 Parcel Post ARTONE
SHI Postage Paid

II»IE&DN COM SERVICES, INC
24300 NANDINAAVE

MORENO VALLEY CA 92551-9534

S CATION3 oM
s
:
e
TRACKING#: 1Z51R Wi3 03 7358 6543

i
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11 . Frequently asked question

1.Problem: Print over label or print blanks

Cause1: Incorrect position of printing
Cause2: Incorrect page size and print density setting
Solution:

A Note:

Before printing, please make sure the size loaded thermal labels, the print settings
on devices, and the source file are completely the same, to ensure the best

print, you had better to choose 4*6 format when download the labels from

the shipping platform or market platform.

1.Power off your printer and power on again.

2.Long press on feed button for around 3 seconds until printer beep one
noise, release your finger, printer will automatically study the size, the label
keeps back on forth several times, then hold on the correct position.

If the page size or source file is larger than the load label size, it is possible
that it prints over label or print blanks.

A Note:

If you have ensure the page size match the label size and still print over label or
print blanks, please use the snapshot function to print.
(Read the "Part 9 Important tips" of the manual.)

2.Problem: Can't get it to connect computer via USB

Cause1: The printer is not compatible with some computer such as
Chromebook, Linux.

Solution1: This printer is compatible with Windows 7 or later and
MAC OS Xv 10.9 or later. Some windows 7 doesn't work, please
update your windows to higher version.

Cause 2: Inaccurate operation

Solution2: please ensure the printer and computer has been connected, and
the printer is on before installing the driver, otherwise, it will cause failing to
install the printer.
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3.Problem:The solution to the problem that Printer spites out
a couple of blank labels

Possible cause 1: The print layer doesn’t face up
Possible cause 2: Incorrect position of printing

Solution:

1. Please make sure that the print layer faces up before printing.

2. Long press on feed button for around 3 seconds until printer beep one
noise, release your finger. Printer will automatically calibrate the place of
the labels, which keeps back on forth several times, then hold on the
correct position.

4.How to deal with the problem that the labels come out slowly
and make a big sound

®Problem: The labels come out slowly and make a big sound.

®Possible cause: Sometimes if the setting of print speed is too low like
2 or 3, it will cause the it print too slow and make a sound, this is an
individual phenomenon, not all the printers have this problem.
So just need to adjust it to higher value like 8. Find the solution below
according to the type of your computer.

@ Solution:
8 Lzbel Printer Printing Preferences b4
For windows: Loy Papausbly, Poge Sohp Aot
113 M n ” . n s‘mrt
Go to “setting” >>"device” >> N 10 v 52
"printer & scanner”>> :
M M Hew Edit Detate
find the printer>>
“Label Printer”, click “manage” W = T L
>>Printing preference >> = I owat: [T =]
Page Setup>> '“ll.l;. [ Porirall 180 i:::::::!llmm;“ mm
adjust the print speed to 8 as =D i
picture show. e A ™

Millst Settings

Methad; | Direct Tharmal - Type: [Label With Gaps = |

GoptHark Halght: |7 = Gapharkcofiset: 0 = g

Madia Handing

Post-Print: [Wona =]

Ocenrrance  |Mhor Evary Fage Foaomet- N =

o | cancel By
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For Mac:

To solve this problem, please follow the steps below:

a.Check the print speed setting on your computer and adjust it to 8.
b.Open asample PDF file in size of 4«6 inch , click print.

c.Click “printer preference”>> Choose” printer feature”>> set up the
“Print speed” to highest value of 8.
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5. Problem: Bluetooth shows “driveris unavailable”

Solution: If you get the message “driver is unavailable “for printer
“Label_printer_xxxx’, Please ignore it, because it is just a Bluetooth name
of printer and will not affect the usage for printing via Bluetooth.

Choose correct printer “Label_printer_xxxx’ to print.

6. Problem: Why Label Printer ( Label printer/Label printer Bluetooth version )
is “Offline” state?

Cause:lt maybe that the Port in computer or hub which you insert the
USB cable into is different from the one you insert at the first time,

so the printer state is Offline and could not print.

Check its status via "Settings">"Devices">"Printer & Scanner”.
Solution:Every time you plug USB cable into the computer,

make sure it's the same port.

7. Problem: Printer spites out Labels with words uncontrollably and
automatically.

Cause:lt maybe that the Port in computer or hub which you insert the
USB cable into is different from the one you insert at the first time,

so the printer state is Offline and could not print. It will cause the printing
task to pile up. Check printer's status via "Settings">"Devices">"

Printer & Scanner”. When you plug again the USB cable into the port
which you firstly plugged, stacking up tasks will be printed at a time.

Solution:Every time you plug USB cable into the computer, make sure
it's the same port.

8. Problem: Barcode came out some black blocks, and serrated at

i

Cause:The reason is that maybe you use the PDF software of Preview
(MAC system). Some PDF is processed by the PDF software, and the font
and barcode are deepened automatically.
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Solution 1: Setting the Print Density value to about 4 in E'
Preview (MAC system).

Video link: https://youtu.be/i7TuWzuWWGr8 Lt
Video Source: Mike Richard.

Solution 2: Open the PDF file via Adobe reader to print. E

[=]

5

9. Problem: Labels come out funky and not legible.

I

$400 1083 0549 8574 5842 90 T |

il

E e . e 30 i

Cause: The resolution of the file you print is too low.

Solution: To ensure the best print, we suggest:

1.Ensure the label you printis 4«6 inch size, only this size can be print on
“FBA print” App. App doesn't support customized size.

2.Save the label as PDF file instead of image.

3.If you still want to print with images, please use high-resolution pictures.

10. Problem: The APP is unable to cut and print the file.

Solution: Currently the APP only supports to print labels in most common
size 46 inch. The new APP with new function of size customized will be
launched in Aug., 2021. So, before you print via phone, please ensure below:

1. Please make sure that the size of the file you upload is 4x6, in case the
printed content over the label

2. Make sure the size of the source PDF, the paper size in setting,

the loaded labels are matched the same.

3. If you want to print labels in other sizes, we suggest you use PC or MAC
with the snapshot function to cut the size of the PDF file

(Concrete operations please refer to Part 9).
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11. Problem: “Shipping Printer” app freezes when using

Possible cause: Sometimes, the interface of the app is not suitable to
IPad if you place your iPad Horizontally and it will freeze.
Solution: Before printing, please place the iPad vertically to print.

[l o

o0
o/
} Ll
Ture . /\
False

12.Problem: Why sparks coming from the back
when plug in the power port.

Solution: Please follow the correct steps to connect
the power.

1. Ensure the printer is off

2. Attach the power cord to the adapter.

3. Connect the power

4. Plug the power cordinto the socket

5. Connect the USB cable to the printer.

6. Connect the printer and computer

7.Turn the power on
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12 . Maintanance

CLEANING THE PRINT HEAD

The printer head is a sensitive part of the printer and can be found on the
upper part of the printer when open.

Caution:While the printer is running the printer head can be very hot.

1.Ensure that the power switch is OFF,remove the power cord,and open the
cover . wait several moments to ensure that the printerhead cools down.

2.Completely clean the printer head using an alcohol swab like the one
provided.

Any 70% Isopropy! Alcohol pad would work . Please do not use water.
3.Wait 2-3minutes until the alcohol has completely dried, then close the
cover.

4.Connect the power cord and print a test page to check if it is clean.

13 . Pro tips

- Anytime you'd like to change your label size,run the automatic label
identification by pressing and holding the feeder button until you hear one
short beep.

- Press the green feeder button on the printer to skip a blank label.

- To run a self-test,press and hold the feeder button until you hear two short
beeps.

- Avoid using poor quality labels as they can damage the printer.

- Regularly clean the printer head as outined above,under MAINTENANCE.

- If paper is jammed,turn off the printer,and allow the printer head to cool
down.Open the cover and ensure that the rubber is clean.If it is dirty,use
alcohol pad to clean it.Allow the area to dry before turning the printer back on.
- Insert the printer's USB into the USB port on your computer every time

you plug it in.This will avoid creating duplicate copies of the printer on your
computer.
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14 . LED indicator

COLOUR OR STATUS
OF LED BUTTON

EXPLANATION

SOLUTION

Green

Printer is running
normally

Flashing Green

Printer Head is
overheated

None. Printer will
automatically resume once
the printer head cools down.

Flashing Red
(every 2 seconds)

1.0ut of paper
2.Wrong size paper

Ensure that the labels are loaded
correctly.You may need to run
automatic label identification

(point 6 in step4).

Flashing Red
(2 times per second)

Printer cover is not
fully closed

Check that the printer
cover is completely closed.

15 . Safety tips

- The printer head can become very hot after printing labels .Do not touch
the printer head until it has cooled.
- Do not bend the power cord excessively or place objects on the cord. This
could result in fire or electocution.

- Keep the printer out of reach of children.
- Use only approved accessories and do not try to disassemble or repair the

unit by yourself.

- Keep the printer away from water and other objects that may destroy or

damage the device.

- Printer should remain unplugged when not in use for long periods of time.
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16 . Driver removement

For windows:
Before removing, please ensure the USB port has been removed on your computer.
1."Settings” >>"Device ">>"Printer & Scanners” >> "Label Printer”>> “Remove device”

Printers & scanners
= M

BY-245BT_FF78
Driver is unavailable

Eg-]]ﬂhc

Hewlett-Packard HP Laserlet MFP M432

Offline
: : Label Printer
Default
Cpen queus Manage Remave device

Microsoft Print to PDF
(=]
Microsoft XPS Document Writer Are you sure you want to remove thiS

device?
Ig] BHIBWFS FDF

2. Click "Print sever properties”>>Find the driver “Label printer”>> “Remove driver
and driver package”">> Click “Delete”

Printers & scanners

Add pri nters & scanners Troubleshoot your printer

It you can't get your printer to work,
try running the printer troubleshooter

Add a printer canner
=5 dd a printer or s Open troubleshooter settings

Related settings

Printers & scanners

Print server properties
Eg] Adobe PDF
Run the troubleshooter

BY-245BT_FF78
Driver is unavailable

Fax

Hewlett-Packard HP Laserlet MFP M433
Cffline

Microsoft Print to PDF

@ Gh gb
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= Print Server Properties

ity Achranced

a SC-202011 141355

Installed printer drivers:

Name Processor Type
Adobe PDF Converter B4 Type 3 - User Mode
HP Color Laserlet A3/11x.. x64 Type 4 - User Mode
[ ingeaitMicualBagter Dr... x64 Type 3 - User Mode
anced Pdwmi.. xbHd Type 3 - User Mode
Microsoft enhanced Point.. %86 Type 3 - User Mode
Microsoft Print To POF xB4 Type 4 - User Mode
Microsoft XPS Document... x64 Type 4 - User Mode
3
Add.. Bemave.. | Properties
lT] - .- -.' -

Remove Driver And Package

Do you want to remove the driver(s) only, or
remove the driver(s) and driver package(s) from
your system?

(O) Remove driver only.

(®) Remove driver and driver package.! I

Print Server Properties

l Deleting this printer driver package will
“F remove it from the system. Are you sure
you want to delete Label Printer?

X

| Yes I| No |

Remove Driver Package

Driver package information collected.

The following driver(s) will be deleted;

Remove Driver Package

Driver package deleted.

Label Printer (x64)

Driver Label Printer was removed.
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For Mac:
Before removing, please ensure the USB port has been removed on your computer.
1. "Lanuchpad” >>"System Preferences” >>"Printer & Scanners”

FaceTime ] Find My Phote Boath

Stocks

N| -

Sound Prifters & Keyboard
Scanners

1200830 " aBRTO0 - ¥ O

2. Find “ Label printer”>> Click “-" >> Click “Delete Printer”

=~ Label printer
™« Idle, Last Used

Printers & Scanners Q

e Are you sure you want to delete the printer
“Label printer~z
fed- Beeprt BY
U o Idle, Las

¥ I MacBook Pro

Label Printer
Idie

| Share this printer on the network Sharing Preferences...

L&

1 Default printer: = Last Printer Used

Default paper size: AS 5 ?
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Federal Communications Commission (FCC) Statement. This device complies with part 15 of the
FCC Rules. Operation is subject to the following twoconditions:

(1) This device may not cause harmful interference, and

(2) this device must accept any interference received,

including interference that may cause undesired operation. Note: This equipment has been
tested and found to comply with the limits for a Class B digital device, pursuant to part 15 of the
FCC Rules. These limits are designed to provide Reasonable protection against harmful
interference in a residential installation. This equipment generates, uses and can radiate radio
frequency energy and, if not installed and used in accordance with the instructions, may cause
harmful interference to radio communications. However, there is no guarantee that interference
will not occur in a particular installation. If this equipment does cause harmful interference to
radio or television reception, which can be determined by turning the equipment off and on, the
user is encouraged to try to correct the interference by one ormore of the following

measures:

*Reorient or relocate the receiving antenna.

eIncrease the separation between the equipment and receiver.

eConnect the equipment into an outlet on a circuit different from that to which the receiver is
connected.

eConsult the dealer or an experienced radio/TV technician for help.

Warning: Changes or modifications made to this device not expressly approved by Rhemel
(Shenzhen) E-Commerce Co., Ltd. may void the FCC authorization to operate this
device.Note: The manufacturer is not responsible for any radio or TV interference caused by
unauthorized modifications to this equipment. Such modifications could void the user’s authority
to operate the equipment.

RF exposure statement:

The device compliance RF exposure requirement and can installed and used without
restriction.





